
 

File: Advanced XP Lesson 7.doc Rev: C 4/06 

Advanced Windows XP 
Lesson 7 

 
Lesson 7 — Microsoft Word..................................................................................................................1 

Introduction..................................................................................................................................................1 
A Word About Versions................................................................................................................................2 
And What if I don’t have Word? ..................................................................................................................2 
Configuration................................................................................................................................................2 

Toolbars & Menus (does not apply to Writer) .......................................................................................2 
Rulers .......................................................................................................................................................3 
View..........................................................................................................................................................3 
Zoom.........................................................................................................................................................3 

Exercise 7 — Word Processing....................................................................................................................3 
Setting Up Your Page...................................................................................................................................3 

Margin Settings .......................................................................................................................................3 
Paper.........................................................................................................................................................4 
Layout.......................................................................................................................................................4 

Formatting Text ...........................................................................................................................................5 
Determining Format ...............................................................................................................................5 
Selecting...................................................................................................................................................6 
Positioning ...............................................................................................................................................6 
Fonts and Font Sizes...............................................................................................................................6 
Spelling and Grammar Checks ..............................................................................................................7 

Headers & Footers........................................................................................................................................7 
Tables ............................................................................................................................................................8 

 
Lesson 7 — Microsoft Word 

Introduction 
Microsoft Word is a very powerful word processing program that can handle 
just about any task requiring a written document — from a simple note or 
letter to a complete book with illustrations, automated table of contents, etc. 
This lesson assumes that the student has some basic familiarity with Word, as 
it will present some of the less familiar, perhaps more esoteric but certainly 
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very useful features of Word. Frankly, we can only scratch the surface of Word’s 
capabilities, but at least you will have a running start. 

A Word About Versions 
The materials presented here apply primarily to the 2003, 2002, and XP 
versions of Word. There may be minor differences with other Word versions 
such as Word 97, Word 2000 and those versions that come as part of the various 
Microsoft Works packages. They are all similar; however, if your home version 
differs in some respects from the version described here, ask your instructor for 
assistance. 

And What if I don’t have Word? 
Microsoft Word is an extra cost item and is not part of the basic Windows XP 
package, so you may not have it installed on your computer. A less expensive 
option is a package called Open Office (actually it is free although they 
appreciate donations). You may download and install it from the location 
http://download.openoffice.org/2.0.1/ . This is a suite of programs comparable to 
the MS Office Suite, and the word processor is called “Writer.” It is very similar 
to Word, so much of the following explanation and exercises will apply. 

Configuration 
The following are recommendations regarding the configuration of the Word 
program. These are personal choice options based on the author’s considerable 
experience with this program, and will be the setup you find on computers in 
the SSCE lab. You may wish to use the same or similar setups on your own 
computer. 

Toolbars & Menus (does not apply to Writer) 

The default configuration for many Word installations have the standard and 
formatting toolbars on one line (which means you can’t see all of either one), 
and the drop-down menus show the most used menu items first (which means 
the menus constantly change the order of selections). We recommend that the 
toolbars should be on two lines and the drop-down menus provide the same list 
each time. These options can be set as follows: 

Right-click on the empty part of the toolbar area and select Customize. If you 
are using Word 2003 click on the Options tab and check the first two boxes to 
show the toolbars on two separate rows and to always show full menus. NOTE: 
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In some earlier versions of Word the check boxes work just the opposite, i.e. you 
must un-check them. 

Close the Customize menu and right-click again. You will be presented with a 
long list of toolbars. Turn off all except the Standard and Formatting toolbars. 
You can turn on others when needed. 

Rulers 

The default setup displays rulers across the top and left side of the Word 
window, and they are rarely needed. So click on View at the menu bar and de-
select Rulers. If you ever need to see a ruler, carefully move the point of the 
mouse arrow to the narrow light colored line immediately beneath the toolbar 
area, and the ruler will appear. Move the mouse out of the ruler area and it will 
disappear. (This feature not part of Writer.) 

View 

Word can display a document in four or five different views depending on the 
version: Normal, Web Layout, Print Layout, Reading Layout (new in the 2003 
version), and Outline. Select Print Layout for most purposes.1 

Zoom 

Hold the Ctrl key down and use the mouse wheel to zoom to around 110%. You 
should see both edges of the page displayed on the screen.  This is usually a 
comfortable size for entering/editing text. 

Your computer is now in the “standard” recommended configuration. 

Exercise 7 — Word Processing 

Setting Up Your Page 
Before starting a document you should check and/or change the margin settings 
and several other factors regarding page layouts. Please note that the page 
layout display in some versions of Word may differ slightly from that discussed 
below. 

Margin Settings 

1. Open Word. Notice that it automatically starts with a blank document and 
it gives it the name “Document 1”. 

                                                 
1 Writer only has Print Layout and Web Layout views. 
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2. Click on File | Page Setup2 and select the Margins tab. The default 
margins are displayed, and they typically have 1.25 inches set for the left 
and right margins. If necessary, use the spin boxes to change left and right 
to 1”. 

3. As an exercise, use the spin box to increase the Gutter setting and watch 
the preview. You can use this to create a binding margin for a document. 
Reduce the Gutter back to zero. 

4. Notice that you can set the page orientation to Portrait or Landscape. 
Portrait is the default setting. 

5. Click on the down-arrow next to “Normal.” Notice the several options. If, 
for example, you were planning to print on both sides of the paper (duplex 
printing) and your left and right margins were not equal, the Mirror 
Margins setting would set the left and right even numbered (back side) 
page margins the opposite of the odd numbered pages. Leave the setting on 
“Normal.” 

Paper 

6. Click on the Paper tab. The default settings in the USA are to use standard 
8.5” x 11” Letter size. If you are using something different, then use the 
features of the Paper tab to set the paper size, e.g. Legal size. You may 
have to make further margin adjustments for other size papers. 

Layout 

7. Click on the Layout tab. The first setting has to do with Sections — a very 
useful advanced subject not covered in this lesson. 

8. Check the Header/Footer settings. If you were using duplex printing you 
probably would check the Different Odd and Even box which, for example, 
would permit you to put page numbers on the right side of odd pages and 
left side of even pages. Since we will be using a multi-page letter as an 
example, check the Different First Page box. That will let us omit the 
header and/or footer on the first page, but have them appear on all 
remaining pages. 

                                                 
2 In Writer, select Format | Page 
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9. Verify the header and footer spacing. The default is usually 0.5”, but some 
printers (Older Epsons in particular) cannot print on the last half inch of 
the page. Thus, the footer spacing would be set to something like 0.7”.  

At home, if you start with a new blank document and you want a setup applied 
to all new documents, then make your selections and click on the Default action 
button. DO NOT do this at the computer lab. Just close the Page Setup dialog 
box. 

Formatting Text 
You can format text in many ways, but first you must tell the computer what it 
is you want to format, and you do this by “selecting” the text to be formatted. 
You may then position text; change the font, size, color and other factors; and 
delete, copy or move it. Alternatively, before entering text you can select the 
format you want and then start typing.  

Determining Format 

1. Open the “Sample Letter” document in the My Documents folder. 

2. Observe the Format Toolbar and notice that the text where the Insertion 
Point is located is Times New Roman, 10 point, boldfaced, and right-
aligned. 

3. Move the insertion point into the first text paragraph. “Read” the format 
from the toolbar as Century Schoolbook, 11 point, left aligned. 

4. Scroll down to the “We have learned …” paragraph, and click in the various 
formatted areas and read the format from the toolbar. Do the same with 
the centered and right aligned text. 

5. Click the Show/Hide symbol3 (¶) on the Standard toolbar. Notice that this 
symbol appears at the end of every paragraph. In fact, it is automatically 
inserted in the document every time the Enter key is pressed, as this 
indicates the end of a paragraph —a paragraph with no characters in it 
still has this symbol at the end, and Word considers it a paragraph. All 
formatting affecting an entire paragraph is actually stored “inside” the ¶ 
symbol at the end. (I’ll bet you didn’t know that!) Also notice that a small 
dot appears in between words — it appears everywhere a space has been 

                                                 
3 For the curious, this is the “Pilcrow” symbol. 
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entered in the text. (To computers, spaces are just another character like 
an a or a b.) Tabs, if entered, appear as small right-arrows. 

6. Click on the Show/Hide symbol again to hide hidden symbols. Note that 
showing hidden symbols can often reveal why your text seems to be oddly 
formatted. 

Selecting 

Before you can change the format of text (or any other object on a page) it must 
be selected (or highlighted). Examine the following methods for “selecting.” 

1. Double click on a word in a paragraph and notice that it is selected. 
(Anything you type at this point will replace the highlighted word.) 

2. Triple click anywhere inside a paragraph and notice that the entire 
paragraph is selected. Click outside the selected area to de-select. 

3. Use the “drag and drop” method to highlight any part of a paragraph(s), 
then de-select. 

4. Place the Insertion Point at the beginning of a paragraph. Scroll down to 
the top of the next page. Hold the Shift key down and click. Notice that all 
text from “Click” to “Shift-Click” is selected. 

5. Move the mouse cursor into the left margin area adjacent to a line of text 
and until it turns into an arrow pointed up and to the right. Click and 
notice that the line is selected. Click and drag the arrow down and it will 
select multiple lines. 

6. At the keyboard, try Ctrl-A and notice that all text in the document is 
selected. Click anywhere outside a selection to deselect it. 

Positioning 

Place the Insertion Point in any paragraph. Click on the “Center” icon on the 
Formatting toolbar to center the paragraph. Try “Right Align” and “Left Align.” 

Fonts and Font Sizes 

1. Using one of the selection methods described above to highlight some text. 
Click on the drop-down arrow next to the Font box and select a different 
font. Do the same with the Font Size. Try the Boldface, Italics and 
Underline formats. Click on the down arrow next to the Font Color icon 
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and select a color. Click on the down arrow next to the Highlight box and 
select a color. Click outside the highlighted area and observe your changes. 

2. Repeatedly click on the Undo icon on the Standard toolbar (or use the Ctrl-
Z keyboard shortcut) until you have removed all the changes you just 
made. 

Spelling and Grammar Checks 

1. Find the word with a squiggly red underline, position the mouse pointer 
over it and right-click. Select the correct spelling from the list provided. 

2. Find the green squiggly line and do the same to correct misuse of “misses.” 

3. Insert an extra space between two words and notice that the grammar 
checker flags this error. Try inserting two identical words (such as the the) 
and notice that the spell checker flags the repeated word. 

Headers & Footers 
1. Go to the top of the document then click on View | Header and Footer.4 

Notice that a Header/Footer toolbar appears and the Insertion Point is 
positioned in the “First Page Header” area. There is no header text, as we 
didn’t want it on the very first page of the letter. 

2. Scroll down to the bottom of page 1 and notice the footer. Scroll to the top 
of page 2 and notice the header text. This text will automatically appear at 
the top of every page from 2 on. 

3. Click “Close” on the Header/Footer toolbar. 

4. Double click in the Header area of page 2 and notice that the toolbar 
returns. 

5. Highlight “Page 2 of 2” and press the Delete key. 

6. With the Insertion Point still at the right margin of the header, click on 
“Insert Auto Text” on the Header/Footer toolbar, then select “Page X of Y” 
and notice that this automatically appears in the header. 

7. Close the Header/Footer toolbar. 

                                                 
4 In Writer, go to Format | Page. 
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Tables 
The Table function in Word is a very powerful and useful feature for creating 
columnar data. In fact, it is highly recommended that you DO NOT use tabs 
and spaces to create columns of information — always use a table because 
tables will automatically adjust their format to maintain the columnar layout 
even if you subsequently make changes to the format of the information. 

1. Move the mouse cursor somewhere inside the table on page 2 and notice 
that a little cross appears at the upper left corner of the table. 

2. Click on the cross to select the entire table. 

3. Right-click in the highlighted table area and select Copy. 

4. Click on the New Blank Document icon on the Standard toolbar. 

5. When the new document appears, right-click and select Paste. 

6. Highlight “on the Red Sea in WWII” and press Delete. Notice that the table 
automatically adjusts the entire row height to accommodate this change. 

7. Undo the last change and move the Insertion Point to the end of “WWII” in 
that table cell and add the text ” during the African campaign.” Notice that 
the entire table row expands to accommodate the change in that cell. 

8. Place the Insertion Point somewhere below the table (you may need to 
press Enter a few times to get below the table). 

9. Click on the Insert Table icon on the Standard toolbar. Use the drag and 
drop technique inside the box to select a 3 x 3 matrix. Notice that a table is 
automatically generated. 

10. Experiment with entering text in the first table cell. Press the Tab key to 
get to the next cell. (DO NOT press Enter at the end of a cell entry unless 
you want a blank line in the cell, use the Tab key.)  

11. Click to place the Insertion Point in the last cell (lower right corner), then 
press Tab. Notice that a new blank row appears. 

12. Hold the Shift key down and press the Tab key. Notice that the Insertion 
Point backs up to the previous cell. (Tab = next cell, Shift-Tab = previous 
cell.) 
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13. If you have a table that crosses a page boundary, and you want the column 
heading row(s) to automatically repeat at the top of each page, first 
highlight the heading row(s), then click on Table at the menu bar and 
select “Heading rows repeat.” 

14. As you have time, go to the Table menu, make selections and investigate 
the many table options. 

Close and DO NOT save all Word documents. 

 

 


